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Chapter 1

Transport module

The Transport module in Allscripts Patient Flow™ uses intelligent assignments, alerts, and
escalations to notify applicable personnel of transport requests and job statuses. An automated
process locates and rates the available transporters according to various criteria. This functionality
enables managers to maximize staff productivity.

Job-routing technology provides the option to automatically assign the most applicable transporter
without user involvement, which drives efficient operations and fewer delays. Also, supervisors
retain the ability to manually assign transport jobs.
Use Mobile in the Transport Module to complete the following actions:

> View and acknowledge jobs.
> Update job statuses.
> Place jobs to In Progress.
> Delay jobs.
> Cancel jobs.

Note: To cancel transport jobs, verify that you are assigned to the
correct role and permissions by a system administrator.

The following image is an example of a Transport Jobs list.
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Log in to Allscripts Patient Flow™

Users with multiple user roles or access to multiple organizations, can change their access at login
using Check In.

Note: If your hospital usesWindows Authentication as the security method
for logging on, you do not use this procedure to log on to Allscripts Patient
Flow™.

1. On the Allscripts Patient Flow™ login screen, enter your user name and password.
2. To use your default role, click Login.
3. To change roles, clear Use Default Setting, and then click Login.

4. On Check In, expand Roles, and then select or clear the appropriate roles.
5. Expand Organizations, and then select or clear the appropriate organizations.
6. To forwardMessages from the Allscripts Patient Flow™ inbox to your email or pager, select the

delivery method and select the email address or pager number.
7. If available, you can also select Alerts or Escalation messages to receive along with the standard

messages.
8. Click Check In.

Check in to Allscripts Patient Flow
This procedure is required only to change the default roles or organizations you use in the Allscripts
Patient Flow™ application. It assumes that you are set up with more than one role or organization
in Allscripts Patient Flow™. These settings determine your access to various modules and functions.
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You can also specify the types of messages you receive that relate to Allscripts Patient Flow™ and
your role.
The following procedure checks you into Allscripts Patient Flow™ using Check In. The Bed
Management role is used as an example.

1. After removing the check mark in theUse Default box and clicking Login,Check In is displayed.

Figure 1: Check In
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2. In My Assignment, click Roles and click the boxes on the list to select the roles you want to
use in Allscripts Patient Flow™. Only your assigned roles display as options. When finished,
click outside the list.
The selected roles displays in Roles. Organizations becomes available.

3. Click the Organizations arrow and click the boxes on the list to select the organizations you
want to work in for Allscripts Patient Flow™ activities. Only your assigned organizations display
as options. When finished, click outside the list.

Note: Transport Dispatchers who use the Auto-Dispatch mode (on
Operational Maint. Tools) must check into their Transport Regions
on the Organizations list.

The selected organizations displays in Organizations.My Messages becomes available, and
by default, the In Box box is checked. This ensures that messages sent to you using Allscripts
Patient Flow™ go to the Inbox in the Messages section.

4. If you want to use additional message delivery methods (Email or Page), do the following in
the Messages section:

> Click the box next to the message delivery method to select it.
A check mark displays in the box.

> For the methods chosen, click the corresponding arrow to select an option, such as an email
address or pager number.
The selected option displays in the box.

5. The Messages box displays Standard by default, enabling you to received standard Allscripts
Patient Flow™ messages. This cannot be cleared. To subscribe to additional message types
such as Alert or Escalation, click the Messages arrow and click the applicable boxes.
If selected, Alert or Escalation displays in addition to Standard in the Messages box.

6. Click Check In to check into Allscripts Patient Flow™.
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You are logged on, and the Allscripts Patient Flow™ application displays a splash page similar
to the following image.

Figure 2: Allscripts Patient Flow™ splash page

Transport Worklist page areas and terminology
Terminology for Allscripts Patient Flow™ pages areas are identified in Transport Worklist. These
areas are explained in the following sections.

Figure 3: Transport Worklist
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Note: For best viewing of Allscripts Patient Flow™, your web browser must
be in Full Screen mode and your monitor set at a minimum of 1024 x 768
resolution.

Left navigation pane for Transport
The left navigation pane displays buttons for Allscripts Patient Flow™ modules and functions. The
name of the module and function and its associated icon display on the button. When you click a
specific button, various options for that module or function display. For example, when you click
Transport, the various pages associated with that module display, such as Transport Worklist
and Check In/Out. The following figure displays buttons for all Allscripts Patient Flow™ modules,
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but only the modules your hospital has purchased will display as buttons. The left navigation pane
also contains a Messages section that is described in the Messages section.

Figure 4: Transport Module

Pin button to expand or collapse left navigation pane
The button on the right of the module name enables you to expand or collapse the pane.
When you initially open Allscripts Patient Flow™, the default view of the left pane is pinned
(expanded). The pinned view displays the names and icons of the module or function buttons,
associated options, and the Messages section.

Clicking the pin button changes the display of the pin and the pane is now unpinned.
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When you click an option, such as Transport Worklist, the left pane collapses so that only the
module icons display. The option you selected, such as the Transport Worklist, is expanded in

the right pane. The pin button changes to an arrows button at the top of the left pane. Clicking
this button expands the left pane back to its original default view. The pin button displays again,
and the pane is still unpinned. Clicking the pin button changes the pane to pinned, and when you
click an option, its details still display in the expanded view in the right pane.

Figure 5: Transport Worklist

Messages section
When the left navigation pane is in the expanded view, the Messages window is displayed. The
window displays messages that were sent to you automatically (application generated messages)
or manually by an Allscripts Patient Flow™ user.

The total number of messages is displayed in Inbox (for example, ). Also, the messages
are displayed in a list, as demonstrated in the following image.
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Links bar
Use the links bar at the top of the page ( ) to log out, check out of
the session, open an administrator workspace, access Help, or log in to the analytics portal.

> Click Logout to log out of Allscripts Patient Flow™.
> Click Admin to open Allscripts Patient Flow™ as an administrator. To exit, click Exit Admin.
> Click Help to open Online Help, where you can access information and workflows on using

the Allscripts Patient Flow™ application.
> Click Analytics Portal to open Allscripts® Logic login page.
> Click your user ID in the links bar to open Check Out, where you can check out of the current

Allscripts Patient Flow™ session.

Scroll bar for multiple records
If the information records are too numerous to display on a worklist or page, use the vertical scroll
bar that displays on the right of the page. Click and drag the scroll bar up or down to find a specific
record.

Page navigation bar for multiple pages of rows
This section describes the how to navigate from a list of rows that is displayed on multiple pages.

If the rows of information are too numerous to display on one page, the list of rows display on
multiple pages. A page navigation bar shown displays on Transport Worklist indicate the number

of rows and pages. You can go to the next page by clicking the Next Page arrow or to the last

page by clicking the Last Page arrow . If there is a previous page, you can go to it by clicking

the Previous Page arrow or to the first page by clicking the First Page arrow . If there are
no previous or next pages, the icons are not available. The following figure shows that there are
no previous pages because you are on Page 1.

Figure 6: Navigation Bar
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Icons
An icon is an image on the Allscripts Patient Flow™ panel that represents a function or activity. If
you point to an icon, a panel tip displays with a brief description of the icon. For example, point to
the calendar icon ( ) to display Open the calendar window.

Common screen buttons
Buttons display near the links bar on Transport module. The following table provides information
about the function of each button.

PurposeButton

This button displays on Transport. Clicking this button
displays Patient Locator to search for a patient.

This button displays on Transport. Clicking this button
displays Transport Request .

The Search button displays on Transport Worklist and
Check In/Out (only when you are on the All tab ). Clicking
this button displays Search. On Transport Worklist, you
can search for transport jobs by the Last Name of the
patient, Job ID, Location, or Employee Last Name. On
Check In/Out, you can search by Employee or Device ID.
If an item matching the search criteria is found, the window
displays only the matching rows. If no items are found, No
Results displays. If results are found, is replaced by the
All Results button, which can be clicked to clear the Search
filter and show all in formation.

Or

Export displays on Transport Worklist andCheck In/Out.
Clicking this button provides the capability to export the
data to a file format such as Excel® or to print the data.

Refresh displays on TransportWorklist andCheck In/Out.
OnCoverageMap, theApply button works like theRefresh
button. Clicking theRefresh button automatically refreshes
the information.

June 23, 2022 | Allscripts Patient Flow™ 22.1 16
Transport User Guide
Copyright © 2022 | Allscripts Healthcare, LLC
This page contains Allscripts proprietary information and is not to be duplicated or disclosed to unauthorized persons.

Transport Worklist page areas and terminology



PurposeButton

If a new tab is created with Filter options on Transport
Worklist and Check In/Out, you can click the tab and the
Filters button becomes available. Clicking this button
displays Filters. This window enables you to define or
change criteria to filter the patient information. Using this
function enables you to find specific information more
quickly, for example, only transports to a specific location.

Select a specific organization (facility, unit, or pod) for
Transport
All main pages have an Organization selector box that enables you to choose the facility, unit, or
pod you are authorized to access for the display of data pertaining to those organizations.

On most main screens, this box is on the top left of the screen. If you are authorized to access
only 1 facility, unit, or pod, then the names of those organizations display automatically in the
Organization selector. If you are authorized to access multiple organizations, you can choose
facilities, units, or pods (based on your authorizations) from the ones currently displayed in the
Organization selector by following the procedure below, which uses Transport Worklist as an
example.

Note: The buttons on the Organization selector box vary slightly on the
Transport pages. The steps below show all the different types of buttons,
found on the various pages.

1. Click the arrow on the right of the Organization selector box.
The facilities you are authorized to access display in a list (which only displays for about 5
seconds). The facility currently selected has a minus symbol in its adjacent box, indicating
that not all of its associated units and pods are selected. On the left of the facility boxes are
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white arrows pointing to the right, indicating that the list is collapsed. An asterisk (*) indicates
the organizations you are checked into.

Figure 7: Transport Worklist

2. Do 1 of the following:

> To change pod selections in the same unit, go to step 3.
> To select another unit or pod in the same facility, go to step 3.
> To select a different facility, go to step 7.

3. To change pod selections or select another unit or pod in the same facility, click the white arrow
on the left of the selected facility.
The currently selected unit and pods display check marks in adjacent boxes.

4. To change pod selections in the same unit, do 1 of the following:

> To clear a pod, click the box to remove a check mark.
The check mark is removed next to the cleared pod. A red outline displays around the
Organization selector box to indicate that changes were made.

> To select a different pod, click the box to insert a check mark.
A check mark displays next to the newly selected pod. A red outline displays around the
Organization selector box to indicate that changes were made.

5. To select another unit in the same facility, click the box on the left of the unit.
A check mark displays next to the newly selected unit. All associated pods are automatically
selected.

6. If you are finished making changes, go to step 9.

7. To select a different facility, click the Expand All button .

Note:
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You can expand a specific organization by clicking the white arrow on
the left of the specific organization to display the organization's units
and pods.
Expand All is available on Transport Worklist, Check In/Out,
Coverage Map, Employee Schedules, and Status View.

The Organization list expands to display all facilities and units (this can take some time if there
are many organizations to display). The arrows next to the facilities and units become black
and point down and to the right.

8. Do 1 of the following (you can scroll down to perform some of these actions):

> To clear all organizations by removing all check marks, click .
All check marks are removed and all organizations cleared.

> To select all organizations by inserting check marks in all boxes, click the Select All button

.
Check marks are inserted in all boxes and all organizations are selected.

> To clear an individual organization, click the adjacent box to remove the check mark. The
check mark is removed and the organization is cleared.

> To clear an individual organization, click the adjacent box to insert the check mark. The
check mark is inserted and the organization is selected.

Note: The X and check mark (replace) are available on Transport
Worklist, Check In/Out, Coverage Map, Employee Schedules, and
Status View.

9. Click the UpdateWorklist button to refresh the information displayed. The button is available
on Transport Worklist, Check In/Out, Coverage Map, Employee Schedules and Status
View.
The Organization list closes, and the red border around the box is removed. The associated
page refreshes to display the information for the selected facility, unit, and pod. If all children
(for example, pods) for a parent (for example, unit) were selected, then only the name of the
parent organization (for example, CARD) displays in the Organization box.
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Transport Request window
From Transport Request, search for a patient and generate a transport request.

Transport Request is displayed in all Allscripts Patient Flow™ modules. Clicking displays a
Transport Request window on which the Facility and Request Type can be selected. If a patient
transport is selected, a Patient Search section is displayed for you to search for the patient by Last
Name, Medical Record Number (MRN), or Acct # (Number). ClickingGo displays a large Transport
Requestwhere you can enter details for the request. The following figure shows the large Transport
Request window. This figure is only an example and might not contain the same values as your
Transport Request.

Figure 8: Figure 12: Transport Request

Some information might be filled based on default information for the transport request type. Boxes
are user-defined and can differ depending on the hospital. The following table explains the boxes
on this Transport Request. This table contains values from the previous example figure and might
not match your Transport Request.

PurposeData

Request Information Section (Some boxes are displayed twice for Round trip Transport.)

This box is filled by default and cannot be changed.Type
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PurposeData

Select the priority for the transport request. The default
value is Routine. Some transport requesters cannot
see Priority depending on their permissions.

Priority

Select the region for the Transport Request. The default
value is the region with which the portal is associated.
If you do not have the applicable permissions, this box
is unavailable and is shaded to indicate the value
cannot be changed. Most transport requesters cannot
see Region based on the their permissions.

Region

If the transport request is a round trip, select this option
for transport personnel to stay with the transport job. If
this transport request is for a material transport or if it
is not a round trip, this box is unavailable.

Stay with Job

If the transport request is a round trip, select this option.
If this transport request is a material transport, this box
is unavailable. When this box is selected, you can select
a specific unit and room for the transport.
To add another transport that is not part of a round trip,
click Add. Another section with From, To, and Pick-up
Time are displayed for this additional leg.

Round trip

If the transport request is a round trip, this option is
unavailable. Select this option if the transport is for a
permanent move.

Permanent Move

If any other scheduled appointments exist for the
patient, they are displayed here. If there are none, then
No records to display is shown in this box.

Scheduled Appts.

The default location is the Facl/Unit/Pod portal for the
patient. To change the location, click the From arrow
and select a location.

From*

Click the To arrow and select a location. If the Transport
Type is configured for a default location, it is displayed.
To change the location, click the To arrow and select
a location.

To*
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PurposeData

The system determines the next available date or time
based on system configuration and displays the date
and time in the Pick-up Time box.
For a round trip transport, the transport type's duration
is added to the first leg’s date and time to calculate the
second leg’s date and time.
For a patient transport job, click Edit to enter a different
time. Schedule is displayed, and you can drag the
transport job to the applicable time or date. For an
equipment transport job, Edit is not displayed, but you
can click inside Pick-up Time and change the date or
time.

Pick-up Time

Needs Section

Select the MOT (Mode of Transport).MOT

Select Personnel (Personnel 1).Personnel

Enter the number of personnel for Personnel 1.Qty

Select Personnel (Personnel 2).Personnel

Enter the number of personnel for Personnel 2.Qty

Select the applicable Isolation boxes. (This is a
configured area.)

Isolation boxes

Select the applicable Confidentiality boxes. (In the
example, Patient Confidentiality is the only option. This
is a configured area.)

Confidentiality boxes

Select the applicable Requirements boxes. (This is a
configured area.)

Requirements boxes

Notes Section

Enter the information for the note.Add Note

Select the box to make the note visible to all users or
clear the box click prevent the note from being visible
to all users.

Note visible to all users

Enter the phone number for the request. The application
provides the phone number of the requester if a phone
number is identified in the application.

Phone
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Open multiple browser windows
The Allscripts Patient Flow™ application supports using multiple browser windows at one time
using Internet Explorer®.

For example, log on to Allscripts Patient Flow™. To open another window, click File > New Session.
Then navigate to Allscripts Patient Flow™ and open a second window. If necessary, repeat the
steps to open other windows.

Log off from Allscripts Patient Flow
For security reasons, whenever you are taking a break or leaving your computer, you must log off
from Allscripts Patient Flow™. Click Logout on the Links Bar. The message stating You have
successfully logged off displays, and you are logged off from Allscripts Patient Flow™.

Note: Logging off from Allscripts Patient Flow™ is not the same as
checking out of it.
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Chapter 2

Transport module overview

The Transport module enables hospital staff to effectively manage Transport Requests and
efficiently complete them. Through the use of an automated Intelligent Matching Engine (IME)
process, Transporters are rated for availability. The IME process starts search and match terms
to score the Transporters independently and find the available Transporters that match the Transport
Request. For example, the Transporter’s region is matched to the requirements of the Transport
Request. If there is no match, the Transporter is eliminated from the results. The IME process also
calculates the percentage of request requirements matched by the Transporter. The matching
Transporters are listed according to their rating with higher-rated Transporters listed first.
Assignments can be performed automatically through Auto-Dispatch or throughmanual assignment.
The Transport module provides check-in or check-out capability, organization coverage information,
scheduling capabilities for employees or devices, and tools for configuration. It also provides the
ability to quickly communicate to Transport staff using communication devices such as pagers.
These functions are described in the following sections.

Note:
Daylight Saving Time
This known issue impacts countries and states that observe Daylight
Saving Time. Once a year, during “Spring forward”, an hour is lost after
midnight. Please note that housekeepers and transporters who check into
Allscripts Patient Flow™ during that time will show as logged in an hour
late that day, due to the loss of the hour. If this is a concern, use your time
and attendance system to review their actual hours worked.
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Access the Transport module
To access the Transport module, click the Transport button on the left navigation pane.

Figure 9: Transport > Transport Worklist

Transport module pages
The Transport module has 7 main pages with the following uses:

June 23, 2022 | Allscripts Patient Flow™ 22.1 25
Transport User Guide
Copyright © 2022 | Allscripts Healthcare, LLC
This page contains Allscripts proprietary information and is not to be duplicated or disclosed to unauthorized persons.

Access the Transport module



DescriptionTransport module

Displays details of open Transport Requests. This page enables
you to view suggested transporter assignments, assign and release
Transporters, view details, put in progress, edit, delay, complete,
or cancel Transport Requests.

Transport Worklist

Displays employees that are checked in and out and the devices
assigned to them. Employee Device IDs, schedules, transport
regions, and the minutes they have been idle, on break, or busy
are also shown. This page can be used by Transport personnel
to search for and check employees in and out, put them on or off
break, and so on. Check In/Out has an Export function that
enables the exporting of data to various file formats, such as Excel®

and Acrobat® PDF.

Check In/Out

Shows the primary, secondary, and tertiary transport coverage
according to transport regions based on the time interval selected.

Coverage Map

Depending on the application configuration, displays a list of
employees or communication devices (such as pagers) and the
available schedules (dates, days, check-in time, regions, and so
on). Schedules can also be added, edited, or removed using this
page.

Employee/Device
Schedules

Provides the capability of viewing, adding, editing, or removing
schedule templates.

Schedule Templates

Provides the capability of Auto Dispatch mode for 1, multiple, or
all regions.

Operational Main Tools

Displays the status of Transport Requests. The requests can be
displayed according to various statuses or sort options. With the
applicable authorizations, you can print, edit, or cancel a transport
job as well as add a note to it.

Status View

Your access to each page is based on your specific role in the hospital. You can have access to
1 or multiple pages. Only the pages that you can access display when you use the Transport
module.
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Common workflows
Use common workflows in Allscripts Patient Flow™ such as searching and filtering views or worklists,
locating patients, or viewing patient histories.

Enter information in required boxes
This section provides a short description on how to use Add Template.

When creating a new item or editing an existing item, most required boxes are indicated by an
asterisk (*) on Allscripts Patient Flow™ pages (and in box descriptions in this document). If
information is missing from a required box, an error icon might display on box. An error message
might display. If required information is missing from a page, you must enter it before you can save
all information on the page. For example, when you use Add Template to create a new template,
you must enter information in the required boxes in order to add a template.

Figure 10: Add Template
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Security timeout
For security and privacy reasons, Allscripts Patient Flow™ has a timeout functionality, which
automatically logs you out of the application after a specified time of application inactivity.

If you log on to Allscripts Patient Flow™, but do not use it for a specified length of time, the panel
automatically closes and the Allscripts Patient Flow™ Please Login panel displays. You must log
on again to access the Bed Management module. Save your changes periodically because if the
timeout feature logs you out, any unsaved changes are gone and cannot be recovered.

Note: Specified timeouts are configured by your organization's system
administrator.

Sorting information by column heading
Several windows, such as Check In/Out, display information in a table format with columns and
rows. Each column has a heading to indicate the type of information in that column. Some column
headings can be clicked to sort the information according to that heading. For example, clicking
the Employee column heading on Check In/Out sorts the information by the employee name.

Figure 11: Check In/Out

Expanding and collapsing rows
The rows initially displayed on Transport Worklist show a short summary of Transport Request
information. This collapsed view displays more jobs on the window.
You can expand the information displayed in a collapsed row by clicking the specific row. This
expanded view displays more details for that transport job. To collapse the expanded view, click
the row again.
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Use tabs and filters
The information in this section only applies to the Transport Worklist and Check In/Out because
the other pages do not use tabs for filtering information. The All tab displays near the top left of
the pages. It is the first and only tab that displays by default on these 2 pages. All data pertaining
to the page displays on the All tab.
To filter out data you do not want to view, first you create a new tab by clicking the Add Tab icon

, and then you select filter criteria on Filters. Data that do not meet the specified criteria are
filtered out and do not display on the page. This Filters function helps you to find specific information
more quickly. Because Transport Worklist and Check In/Out display different data, Filters for
the Transport Worklist has different boxes than Check In/Out.
You can select 1 or multiple options for each box on Filters. If you do not want to use a box, leave
it blank. For example, if you want to look for transport requests that have not been assigned to a
Transporter on Transport Worklist, click the Request Status arrow on Filters and click the
Unassigned box to insert a check mark. To search for these requests for Stat jobs only, you would
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also click the Request Priority arrow and click the Stat box to insert a check mark. Leave the
other boxes on Transport Worklist Filters blank.

Figure 12: Transport Worklist Filters

When you click Filter Now, the page closes and only Unassigned and Stat Transport Requests
display on Transport Worklist. If no data matches the filter criteria, the statement No records
to display. is shown onWorklist. In order to use this Filters function, you must create and
name a Filters tab, which is used to save the Filter options you specify. The name of the new
Filters tab displays on the right of the All tab. This Filters tab is saved and displays on your view
of Transport Worklist or Check In/Out whenever you access it. It does not display to other
transporters. If you no longer want to use the tab, you can delete it.
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Create a Filters tab
Create a Filters tab for unassigned transport jobs on Transport Worklist. Use the filter tab as an
example and create multiple types of tabs using the same process.

1. Click Transport Worklist.

Transport Worklist displays the All tab and the Add button on the left.

Figure 13: Transport Worklist

2. Click on the left of the All tab.
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3. Enter a Tab Name and select your filtering criteria.

Figure 14: Transport Worklist Filters

4. Click Save.
The filter information for the Stat tab is saved. Transport Worklist Filters closes and only
Transport Requests that have the Stat priority display. If no requests match the filter criteria,
the statement No records to display is shown. The Filters button becomes available.
You can click this button to display Transport Worklist Filters again and edit the options you
selected as explained in the following section.

June 23, 2022 | Allscripts Patient Flow™ 22.1 32
Transport User Guide
Copyright © 2022 | Allscripts Healthcare, LLC
This page contains Allscripts proprietary information and is not to be duplicated or disclosed to unauthorized persons.

Common workflows



Note: On created filter tabs like Stat, Search on the Transport
Worklist is not functional because the data is filtered.

Figure 15: Transport Worklist

Edit Filters
Change the filter criteria for a filter tab you created.

Click the pencil on the tab to change the selected filter criteria.

Delete Filters tabs
Delete filter tabs you no longer need. You cannot delete the All tab.

You can delete a Filters tab that you created by clicking the x on the tab.
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On Confirm click Yes to delete the tab.

Use the All tab
Clicking the All tab next to the Filters tab displays all data associated with that window. No data
is filtered out on the All tab.

View, send, and delete messages
Messages provides the ability to view, send, and delete messages within Allscripts Patient Flow™.
It does not have the same functionality as an email application, such as Microsoft® Outlook®,
because it is limited to people and organizations defined in Allscripts Patient Flow™. The left
navigation pane must be in the expanded view for the Messages section to display.
Message configuration is defined in the Administration area, and your System Administrator sets
you up to receive the applicable types of messages (for example, Standard, Escalation, and Alert)
and to subscribe to various messages by default. If you have the applicable authorizations, you
can click Account Settings and change these message settings on Check Out and Message
Event Subscriptions.

View messages
The total number of messages received, for example, 2, displays in the Inbox icon , and the
messages display as a list near the icon. Messages display in chronological order with the most
recent message displaying first. The first 30 characters of a message display in the Messages
section. Depending on the length of the messages, 6 or 7 messages are displayed in this section.
If numerous messages are received, a scroll bar displays on the right of the Messages section,
and you can click and drag the scroll bar up or down to view messages. You can display an
expanded view of messages by following the procedure.

1. If the Messages section does not display, click .
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The Messages section displays.

Figure 16: Messages

2. Click Inbox (the number in the Inbox icon varies according to the number of messages received).
The expanded view of the Messages Inbox displays on the right.

Figure 17: Messages Inbox

3. To sort the messages, you can click the Sort By arrow and select an option. You can also
select the sort order by clicking Descending (default) or Ascending.
The messages are sorted by the options selected.

Create and send messages
Create and send messages using the Messages functionality in Allscripts Patient Flow™.

1. Click to expand the left navigation pane and display the Messages options.
2. From Messages, complete one of the following steps:

> Click .

> Click Inbox and then click .
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3. Select a recipient name from the list.
4. (Optional) To search for a specific recipient, enter a name into the Name field and press Enter.
5. Click Add.
6. In Message, enter any text.
7. Click Send.

Delete messages
To delete an individual message, click the Delete icon on the right of the message. To delete all
messages, click Delete All. The maximum number of days that messages are retained is set by
your System Administrator. Messages are automatically deleted when they exceed this maximum
threshold. To recover a deleted message, see your System Administrator.
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Export information
Information on Transport Worklist and Check In/Out can be exported as point-in-time, snapshot

data by clicking Export . Transport Worklist is displayed in a report format as shown in the
following figure.

Figure 18: Transport Worklist

You can also export information onCheck In/Out. If your application is configured to show employee

and device schedules, Transport Employee displays when clicking on Check In/Out. If your
application is configured to show employee schedules, then Transport Employee List is displayed

when clicking on Check In/Out.
An actions bar displays on Transport Worklist, Transport Device, and Employee List. You can
go to various list pages, change the view percentage, perform a text search, select a file format
for export, and print the list. Clicking the arrow button expands the actions bar to display
Report Style and View Report, where you can select the report file format and then click the
button to view the report prior to printing. Clicking the again collapses the actions bar.

Figure 19: Action bar

The functions of the actions bar are described in the following sections.

Move through spreadsheet information
Functions on the Actions Bar enable you to move through the information to view specific records:
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On the left side of the Actions Bar, the current page number and the total number of pages display,

for example . To move to another page, enter the page number in the box displaying
the current page number and press ENTER on your keyboard. The page displays that page of the
report. Navigation arrows display on the left and right sides of the page numbers. To advance 1

page, click the single arrow pointing to the right . To advance to the end of the report, click the

arrow-bar pointing to the right . Similarly, click the arrows pointing left ( and ) to move to
previous pages in the report.

Note: If there is only 1 page in the report, navigation is not needed and

the navigation functions are not available. Also, the right arrows
and are not available when you have reached the end of the report. The

left arrows display in a grey color have reached the beginning of
the report.

To scroll through the records without using the Actions Bar, you can either press the DOWN
ARROW key (↓) on your keyboard for continuous scrolling or press the PAGE DOWN key to scroll
1 section of the page at a time. If there is more than 1 page of records, a Windows® scroll bar
displays on the right side. You can use your mouse and either click the up ( ) and down ( )
arrows to scroll through records or you can click and drag the scrollbar slider to scroll through the
records.

Change the View size
By default, the current report is displayed at 100% size as indicated in Viewon the Actions Bar.

You can change this viewing size by either clicking 100% or clicking arrow and selecting the view
size from the list of options. The view size of the information on the page changes accordingly.

Search for a value
Find | Next in the middle of the Actions Bar provides a Search function.

Initially, Find | Next displays are not available until a value is entered in blank text box. To search
for a value, do the following:

1. Enter a search value in the Find box.
2. Click Find to find the value.
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If the value is found, it is highlighted and displayed on the report page. If the value is not found,
aWindows® Internet Explorer®message stating, The search text was not found opens.
Click OK on the message to return to the report.

3. To find the same value again, click Next.
If another occurrence of the value is found, it is highlighted and displayed on the report page.
If another occurrence of the value is not found, aWindows® Internet Explorer®message stating,
The entire report has been searched opens. Click on the page to return to the report.

Export information to a report

Clicking the Export icon on the right displays a list of export options that can be selected to
export the report data into a different format.

You can export a report to different formats, for example, an Adobe PDF® file, using Export. To
export a report, do the following:

1. Click the Export icon to display a list of available format options.
2. Click to select the format for the exported report.

File Download is displayed.

3. Click Open to open the file or click Save to save the file.
The file is either opened or saved depending on your selection.

Note: To open some formats, such as a PDF file, you must have the
associated program loaded on your computer or an error message
displays. See your system administrator for additional information.
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Refresh information
Click Refresh (on the right of the Export icon) on the Action Bar to refresh the information
displayed on the page.

Print a report
You can print the information as a report by clicking the Print icon on the right of the Refresh
icon on the Action Bar. You can also print the report if you export it by using the Print function in
the export application, such as an Excel file.
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Chapter 3

Transport Worklist

Transport Worklist uses an automated Intelligent Matching Engine (IME) process to rate
Transporters for availability. Their transport region in relation to transport locations is also used
as part of the rating. The available Transporters are listed according to their rating next to the
transport jobs, with higher-rated Transporters listed first. This function makes it easier for managers
to manually assign Transporters to transport jobs. Transport Worklist can be configured to
automatically assign transport jobs to Transporters based on their IME rating. If automatic
assignment is used, the Transporter rated highest for a transport job is automatically assigned to
the job. No manual assignment is necessary.

Access the Transport Worklist
To access Transport Worklist, click Transport.

Figure 20: Transport Worklist
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Information on Transport Worklist

Common icons
Other than the error icon ( ), click a common Allscripts Patient Flow™ icon to use the associated
feature.

Table 1: General icons

PurposeLocationIcon

Collapses the left navigation pane to display
more information on the right of the pane.

Top of left navigation
pane

Collapses the activity pane on the right and
display more information on the left of the pane.

Unit View

Click the down arrows to expand the section
and display any pending activities. Click the up
arrows to collapse the section.

Activity pane on Unit
View

Displays on a patient row if a request is made
for the patient (for example, a Bed Transfer,
or Discharge Request).
Click to display a Cancel panel, where you
can select a cancellation reason.

On the right of patient
rows on most work list
panels

Closes the current panel without saving new
information.

Top right of window and
other panels

Opens a calendar, where you can select a date.Check In and other
panels

Opens a time picker, where you can pick
one-hour time intervals.

Check In and other
panels

Displays when data is missing from a required
box after you try to save information on a panel
or attempt to proceed to the next step.

Data entry panels
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PurposeLocationIcon

Displays when an error is made in a date box
(for example, you enter a future date in Off
Floor Date Time onMove Patient Off Floor).

Several pop-up panels
(for example, Move
Patient Off Floor)

When is displayed, enables you to view
previous notes.
If a note does not currently exist for the patient,

displays. Click the icon to add a note.
Refer to the information in Use the Notes
Function.

Patient row on most
worklists and view panelsor

Displays on the right of the patient's name.
Click this icon or the patient's name to open
Patient Details.

Patient row on most
worklists and view panels

If a very important person (for example, a
celebrity) is selected as a Confidentiality
attribute for a patient, displays on the right
of the patient's name.
This functionality is available when the Very
Important Person box is selected for the
Confidentiality attribute on Attributes
Maintenance in Admin.

Patient row on Portal
View, Unit View, and
Bed Management
worklist panels or the
activity pane on the Unit
View panel

Identifies the material jobs displayed on
Transport Worklist.

Left side of the Material
Jobs tile on Transport
Worklist

June 23, 2022 | Allscripts Patient Flow™ 22.1 43
Transport User Guide
Copyright © 2022 | Allscripts Healthcare, LLC
This page contains Allscripts proprietary information and is not to be duplicated or disclosed to unauthorized persons.

Information on Transport Worklist



Requests List on Transport Worklist
The Requests List displays transport requests in a table format on Transport Worklist. Each table
column has a heading to indicate the type of information in that column. The Location column on
the left contains transport tile icons, which are explained in the following section.

Figure 21: Transport Worklist

Transport tile information
Transport Worklist uses transport tiles to display the 3 types of transport requests: patient,
material, or material for a specific patient.

A person icon in the transport tile indicates a patient transport request. A box icon indicates
a material transport request.

Figure 22: Transport tile
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The following table explains the abbreviations for status timers on the transport tile.

Transport status timers
ExplanationAbbreviation

Minutes (0 to 120 minutes)M

Hours (121 minutes to 23 hours)H

Days (1 to 30 days)D

Months (31 days or more)MO

The following table explains the status abbreviations (in alphabetical order) displayed in the transport
tile.

Transport job request status
ExplanationStatus

The transport job is assigned to a Transporter,
but it is delayed.

ADLY

The transport job is assigned to a Transporter.ASSN

The transport job is delayed in progress, but it
is still assigned to a Transporter.

DLAY

The transport job is delayed and unassigned.DLYU

The transport job is delayed during resource (for
example, an employee) acknowledge.

DRCK

The transport job is assigned to a Transporter,
and the job is in progress.

IPRG

The resource has acknowledged receipt of the
transport job.

RACK

The transport job is unassigned.UNAS
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Clicking the status in the transport tile displays Transport Status Info, which shows the job status
history.

Figure 23: Transport Status Info

The icons displayed on the right of the transport tile are explained in the following table.

Transport job leg abbreviations
ExplanationAbbreviation

The first job included in 1 batchB1:1

The first job included in the second batch.B2:1

The first leg of a round trip transport job.R1

The first leg of a multi-leg transport job.1:4

IME terms used for transport requests
When a transport request is submitted, the Intelligent Matching Engine (IME) starts various search
terms to return the most applicable results. An IME term is code that performs a specific search
rule. A term can calculate a score, delete an item from the results, or add an item back to the
results.

The following table lists the Transport IME terms, which are run in sequential order. The top terms
filter out the largest amount of resources, then the terms narrow the data results down to recommend
the most applicable and available Transporters. The names of these Transporters display in the
Assignment column with percentages indicating the most optimal matches to the request.

PurposeIME Term

Eliminates all Transporters not checked into the
region for the request.

Region Coverage Filter
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PurposeIME Term

Scores a given Transporter based on the value
in the Coverage Level table. The weight is based
on the Transporter’s Coverage Level for that
Transport region (Primary, Secondary, or
Tertiary).

Region Coverage

Filters out those Transporters that do not have
the proper skill to do this job.

Person Skill Level

Compares needs selected during the creation
of a transport request to the attributes of the
available Transporters and either calculates a
score based on how many matches exist or
eliminate Transporters if 1 of the required needs
is not met.

Attribute Need Search

Filters out Transporters that are currently
assigned to the maximum number of concurrent
jobs. Jobs counted are those in the Assigned,
In Progress, Assigned Delay, or Delay state.

Max Assigned Jobs

Filters out Transporters that are currently
assigned to the maximum number of jobs for the
day.

Max Jobs for Day

Adjusts the score based on the Mode of
Transport (MOT) for the request. If the previous
job’s MOT matches the current job’s MOT, the
score is 100%. A Transporter with a strand so
on her for the previous job receives a lower
score if the current job requires a wheelchair.

Mode of Transport

Filters out Transporters that are currently
assigned to the maximum number of jobs for the
shift.

Max Jobs Shift

For a job due now, the search returns the first
available Transporter who is waiting the longest
since the last job.

First In/First Out
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PurposeIME Term

Scores a person from 0% to 100% based on the
ratio: Idle Elapsed Time or Productive Elapsed
Time. Idle Elapsed Time is time spent checked
in and not on a job. Productive Elapsed Time is
time spent checked in and not on break.

Person Load Balance

Transport Request Information column
Use the From/To Location column on the Transport Worklist to view the originating and the
destination locations.

For example, a patient can be transported from his bed, and the Bed ID is shown as the originating
location. The destination location can be another Bed ID or a department, for example, Radiology.
TheMethod of Transport code displays inMOT. The number of personnel and the types of personnel
(for example, T for Transporter) required for the job are also shown in MOT.

Figure 24: Method of Transport (MOT)

The request pickup time and date display in the Pickup Time column.
The code for the specific request (for example, Test Procedure) is displayed in the Transport
Type column. Based on the hospital’s configuration, HIGH and STAT priority jobs can be indicated
if applicable following the Request Type. If the Transport Request is for a patient, the patient’s
name, gender, age, date of birth, and MRN or Account Number display in Patient Information.
If you have the applicable authorizations, you can click the patient’s name to display Patient
Details. The tabs on this page provide more information about the patient.
The Assignment column shows the current assignment status of the request.
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Escalations
If the transport job is escalated (based on your hospital’s configured time settings), the escalation
acronym ESC and escalation level display in bold red font on the job row, for example, ESC1, as
shown in the preceding figure. If the job is not in escalation, no ESC text is displayed.

Urgency status (visual cues)
The transport job row displays a yellow or red dot to the left of the Job Pickup time. This leverages
the urgency codes when the system option TAWN is set to a value. The recommended value is
a minimum of 5 minutes.

The following table explains the transport urgency codes.

Urgency Code DefinitionUrgency Code DescriptionUrgency Code

Estimated transport time based
on the historical average of the
transport time between
locations or a default estimation
based on the transport type

Transport Completion TimeTCMP

Amount of time the job is in the
current state

Time in StateTIST

Estimated pickup time provided
from the transport request.

Transport Pickup TimeTPUT

The background colors are configured for Transport Worklist as described in the following table
(the Urgency Code is in parentheses in the middle column of the table).

Recommended Standard
Configuration

Transport Background Color
Highlight Description

Stat

10 min.If the job is in any of these
states, the application changes
to YELLOW X minutes before
pickup time (TPUT).

Unassigned, Assigned,
Acknowledge

5 min. (YELLOW)Yellow: when the job is within 5
minutes of the estimated
complete time.
Red: When the job is at or
beyond the estimated complete
time.

In-Progress
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“Scheduled” transport jobs
A transport job that does not use the default current date or time shown on Transport Request
is considered a “scheduled” job.

To change the pickup date or time click Actions > Edit.

Transporter assignment information
The transporter assigned to the transport request displays in the Assignment column.

Click Actions > More Suggestions to display a list of available transporters.

An assigned Transporter is indicated by the Unassign (Release) button , beside the
Transporter’s name. An unassigned, but available, Transporter is indicated by the Assign button

.
To display information about the transporter assigned to a job click their name/ID in Assignment.
Transporter Details contains the following information:

> the Transporter’s Region
> Current Status
> MOT
> Location
> Jobs Completed Since Last
> Check In Time
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> Total Idle

Figure 25: Transporter Details

Click Unassign to remove the assigned Transporter from the transport job.
Actions also displays options for taking action based on the status of the transport job:

> In Progress
> Cancel
> Delay

Transport Worklist functions
Transporters can be assigned or unassigned to transport jobs using Transport Worklist. Transport
jobs can also be viewed, printed, acknowledged, edited, delayed, put in progress, and cancelled
on this page. These procedures assume that the applicable organizations was selected in
Organization.
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View Key Performance Indicators (KPIs)
The Dashboard page header on Transport Worklist shows Key Performance Indicators (KPIs).
Click any KPI name to open (or close) a detailed view of the item.

Figure 26: Key Performance Indicators

The information displayed in the Dashboard Page Header at the top of the page can be configured
by the Allscripts® Implementation Team (not by the Administration functions in Allscripts Patient
Flow™). Also, security for each KPI is configurable (using the AdminMode function forDashboards).

Note: The KPI information displays only for transport zones that you have
access to in Allscripts Patient Flow™.

The Dashboard Page Header contains the following information for the selected facility:
Table 2: Dashboard Page Header Information

ExplanationHeader name

The number of open bed-cleaning jobs for the
facility.

Open (Open Jobs)

The number of completed bed-cleaning jobs
since midnight for the facility.

Completed (Completed Jobs)

The bed turnover and request response times.TP Time (Bed Turnover Time)

The number of pending jobs (pending discharges
and pending transfers) for the facility for the next
6 hours into the future.

Future (Future Jobs)

The number of checked-in employees for the
facility.

Emp Count (Checked-In Employees)

Shows if Auto-Dispatch is turned on for each
region.

Auto Dispatch
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Manually create transport jobs
This task describes how to create a transport job.

1. Click Bed Management and then Unit View.
2. Select the unit to which the patient is to be transported.
3. Find the patient and click the transport icon (TP).
4. On Transport Request in Request Type select the reason for the transport, and then click

Go.
5. On Patient Information enter or select the transport details. Fields marked with an asterisk

are mandatory
6. Enter optional information in the Needs or Notes and click Submit.

Assign transporters to transport jobs
Manually assign a transporter for individual jobs or enable auto-dispatch. In addition, if auto-dispatch
is enabled, intervene and manually assign a transporter to an individual job. A transport job that
is not assigned to a Transporter displays as UNAS or DLYU (delayed and unassigned) in the Job
Status column on the Transport Worklist.

1. Find the transport job for which you want to assign a transporter.
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2. If a transporter is listed in Assignment, click . If no one is listed click Actions >
More Suggestions or Actions > Quick Assign.

Note: The quick assign option is not always enabled. It is only viewable
when the QAVS system option is enabled and the transport Quick
Assign and Quick Assign Link Button authorizations are invoked.

3. On More Suggestions select a transporter and then click Assign.

Figure 27: Assign Transporter: More Suggestions
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On Quick Assign click next to the transporter's name, and then click Refresh.

Figure 28: Assign Transporter: Quick Assign

Edit transport jobs
Edit a transport job if it has not been assigned to a Transporter, which is indicated by either UNAS
or DLYU (delayed and unassigned) in the Transport Tile in the Location column. This procedure
uses the example of a patient transport job. A material transport job is similar, except that Schedule
steps are not applicable. You can scroll down or go to another page to find the specific transport
job.

Note: If Auto-Dispatch is enabled and the job is assigned before the edits
are completed and submitted, an error is returned indicating the job has
already been assigned and the edits were not saved.
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1. Find and click the specific row with the transport job.

Figure 29: Transport job

2. Click Actions > Edit.

Figure 30: Patient Information
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3. Enter information changes or make new selections. Required fields are indicated by an asterisk.
If you do not have information to enter in an optional field, leave it blank.

Note: Fields on this window are slightly different for a materials
transport. Also, the fields are hospital-defined andmight differ depending
on the hospital.

PurposeData

Request Information Section (Some fields display twice for Round trip Transport)

This field is populated by default and cannot
be changed.

Type

Select the priority for the Transport Request.
The default value is Routine.

Priority

Select the region for the Transport Request. If
you do not have the applicable permissions,
this field is disabled.

Region

Select if the Transport Request is a round trip
to request that the Transport personnel to stay
with the transport job. If this is a Material
Transport for the patient or is not a round trip,
this field is disabled.

Stay with Job

Select if the Transport Request is a round trip.
If this is a Material Transport for the patient,
this field is disabled. When selected, a second
leg displays with the locations from the first leg
reversed in the From and To boxes. You can
change the pick-up time or remove the second
leg.

Round trip

Select if the transport is for a permanent move.

Note: If this field is selected, a bed-cleaning
job is created for this bed.

Permanent Move

If any other scheduled appointments exist for
the patient, they display here. If there are none,
then No records to display is shown in
this field.

Scheduled Appts.

Select a different pick-up location.From*

June 23, 2022 | Allscripts Patient Flow™ 22.1 57
Transport User Guide
Copyright © 2022 | Allscripts Healthcare, LLC
This page contains Allscripts proprietary information and is not to be duplicated or disclosed to unauthorized persons.

Transport Worklist functions



PurposeData

Select a different destination.To*

For a round trip transport, the Transport Type’s
default duration is added to the first leg’s date
and time to calculate the second leg’s date and
time. Click the date and time icons to change.

Pick-up Time

Needs Section (Fields are Configurable)

Select a Mode of Transport.MOT

Select the Personnel (Personnel 1). Depending
on the request, you a second personnel field
might be enabled.

Personnel

Enter the number of personnel for Personnel
1.

Qty

Select an isolation type, as applicable:

> Airborne Isolation
> Protective
> Contact Isolation
> Droplet Isolation

Isolation

Select a requirement, as applicable. Examples
include:

> Fall risk
> Male only
> Female only

Requirements

Notes Section

Enter the note text.Add Note

Clear to make the note not visible for all users.Visible for all users

Enter the phone number for the point of contact
for the request.

Phone

4. To add another transport leg, click Add. Configure the second leg as applicable.

5. To change the appointment date or time, click the or and select from the calendar or
time picker.
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6. Click Submit.

Place transport jobs in progress
You can place a transport job in progress if a Transporter is assigned to the job (ASSN, RACK,
or DLAY displays in the Transport Tile). If the transport job is in a DLAY (Delayed) status, when
you place the job in progress, the delay is automatically ended.

1. Find the transport job.
2. Click Actions > In Progress.

The Transport Tile shows the new In Progress (IPRG) status, and the timer in the tile resets to
0M.

Figure 31: Transport job In Progress

Complete transport jobs
You can complete a transport job only if it is in the In Progress (IPRG) status.

1. Find the row with the transport job to complete.

Figure 32: Transport job

2. Click Actions > Complete.
The completed transport job is removed from Transport Worklist.

Cancel transport jobs
You can cancel a transport job no matter the job status.

1. Find the row with the transport job to cancel.

Figure 33: Transport job
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2. Click Actions > Cancel. If you cancel a multiple leg job, all remaining legs are also cancelled.

Figure 34: Cancel window

3. In Reason select the reason why the job was canceled.

Note: Clicking Cancel does not cancel the transport job, but closes
the window without canceling the job.

4. Click Save.
The transport job is removed from Transport Worklist.

Delay transport jobs
You can delay a transport job if it is in an Unassigned (UNAS), Assigned (ASSN), Acknowledged
(RACK) or In Progress (IPRG) status.

1. On Transport Worklist find the transport job to delay.

Figure 35: Transport job
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2. Click Actions > Delay.

Figure 36: Delay

3. In Reason for Delay select the applicable reason.

4. In Delay Minutes select the duration of the delay, or for new proposed time click the or
enter a new time in 24-hour format.

5. Select Stay with job if the assigned transporter should remain assigned during the delay.
Clearing this selection removes the transporter assigned to the job.
If the job has not been assigned to a Transporter, the Stay with job box is not displayed on
Delay.

6. Select Automatically end delay after time expires to reactivate the job when the delay time
has passed.

7. Click Save.

Figure 37: Transport job delay
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Edit delayed transport jobs
From Transport Worklist, edit a delayed transport job.

The Transport Tile for the job indicates the delayed status:

> DLAY — Transporter assigned
> DLYU — No transporter assigned
> DRCK — Delay occurred during employee acknowledge

1. Scroll through Transport Worklist to find the specific transport job to edit.
2. Click Actions > Edit Delay.

Note: If the delay has gone beyond the defined minutes, the time for
the delay is displayed in red font (for example, 12M). If you delay a
multi–leg job, all remaining legs might be affected.

Figure 38: Edit Delay window

If the job is assigned to a Transporter, the Stay with job field is displayed on Edit Delay.
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3. Edit or update the following fields. Required fields are indicated by an asterisk. If you do not
have information to enter in an optional field, leave it blank.

PurposeField

Select a reason.Reason for Delay*

Select a delay duration.Delay Minutes

Click and select the time when the delay
ends. You can also enter the time in the
24-hour format (for example, 15:00).

or new proposed time

This field is displayed if the job is assigned to
a Transporter. This field is selected by default,
indicating that the employee stays with the job
during the delay. To change the default and
release the employee from the job, clear the
selection.

Stay with job

Select to end the delay automatically after the
time expires. If Stay with job is not selected,
this field is enabled and is blank, which
indicates that the delay does not end
automatically after the time expires. If Stay
with job is selected, this field is unavailable.

Automatically end delay after time expires

4. To end the delay immediately, click End Delay Now.
5. Click Save.
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Add notes to transport jobs
Add public or personal notes to a transport job.

1. Find the row with the transport job.

Figure 39: Adding Notes

2. Click Actions > Notes.
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Previously added notes display at the top of the window.

Figure 40: Notes

3. Enter the note text in Add Note.
4. To make the note not visible to everyone, clear the Visible to all users selection.
5. Click Save.
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The note as well as the date and time and the creator’s name display on Notes. If the Visible
to all users is cleared, the date or time and the creator’s name display in blue font.

Figure 41: Notes

6. Click Close.

Transport jobs with notes display next to the Actions menu.

Click to display the notes entered for the transport job. Private Message displays
instead of the note text if Visible to all users was cleared when the note was entered.
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Print ticket to ride reports
Print or export a ticket to ride report containing the details of the selected transport job.

1. On Transport Worklist find the transport job to print.
2. Click Actions > Print.

The Ticket to Ride Transport report has the following sections:

DescriptionsReport sections

The Job ID, Transport Type, Request Priority,
Round Trip information, From and To
Locations, Pickup Time (includes the date),
and Stay with Patient information.

Transport Request Details

The Patient Name, Gender, Date of Birth,
MRN, and Account #.

Patient Info
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DescriptionsReport sections

The MOT (Method of Transport) and headings
for the personnel types required for the
Transport Request, for example, Transporter,
as well as the number needed.

Transport Needs

Space for up to 2 lines of text.Additional Notes

This section is intentionally left blank for you
to write comments.

Comments

Personnel in the Release and Receiving areas
to sign and date.

Release and Receiving Signature and Date
Lines

3. To send the report to a printer click . Click and select a format to export the report.
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Chapter 4

Check In/Out

Check In/Out displays a list of employees, their IDs, Devices and other details.

Click Transport then Check In/Out.

Figure 42: Transport > Check In/Out

FromCheck In/Out you can temporarily edit employee schedules, or view details about the regions
or facilities they are checked into. Click column headings to sort the data by:

> Employee
> Employee ID
> Device
> Device ID
> Idle
> Break
> Busy

Figure 43: Check In/Out

June 23, 2022 | Allscripts Patient Flow™ 22.1 69
Transport User Guide
Copyright © 2022 | Allscripts Healthcare, LLC
This page contains Allscripts proprietary information and is not to be duplicated or disclosed to unauthorized persons.



Functions on Check In/Out

Top button functions
The following table describes the functionality of the top eight buttons on Check In/Out. The
Refresh and Export buttons are always available, but the other buttons are available only if certain
conditions are met.

One condition is that the employee or device must be selected. Other conditions are explained in
the following table.

Note: The following procedures assume that the applicable organization
is selected in the Organization box.

FunctionalityButton

Click to open Temporarily Edit Scheduling
Details, and then click Check In to check in the
employee or device.

This is only available if the employee or device
is currently checked in. Click to check out the
employee or device.

This is only available if the employee or device
is currently checked in and the employee is not
on break. Click to openBegin Break. Select the
type of break for the employee or device and
then click Begin Break.

This is only available if the employee or device
is currently checked in and is on break. Click to
open End Break, and then click End Break.

This only displays if you are on the All tab. Click
to search by Employee or Device ID using a
minimum of 3 alphanumeric characters. If an
item matching the search criteria is found, the
windows displays the matching rows. If results
are found, click All Results to clear the Search
filter.

and
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FunctionalityButton

Click to Export open Transport Employee or
Device List, where you can browse to various
list pages, change the view percentage, perform
a text search, select a file format for export, or
print the list.

Click to manually refresh the information
displayed on the current window with the latest
information. If the Automatic Refresh option is
turned on by your System Administrator, these
windows automatically refresh with the latest
information at the time interval set up by your
System Administrator.

If a new tab was created with Filter options, the
Filters button is available when you are on the
created tab. Click to open Filters, and then
define criteria to filter the information displayed.

Links on Check In/Out
Various links display on Check In/Out, which can be clicked to show relevant information. You
can click the employee or device’s name in the Employee/Device column to display Temporarily
Edit Scheduling Details, enabling you to make temporary changes to check in and out times,
breaks, and so on.
The Facility, Region, and Break columns also contain linked information. When you click the links
in these columns, small view-only windows display with more details. For example, the Facility
column has a limited width so only a few characters are shown. If there is more than 1 facility per
employee or device, an ellipsis (…) displays. Clicking the facility name in the column displays a
Facilities window showing all facility names associated with the employee or device.
The link in the Region column works in a similar way. If there is not enough space in the column
to contain the names of all regions associated with the employee/device, an ellipsis (…) displays.
Clicking the region name in the column displays a Region window showing all region names
associated with the employee/device, listing them in Primary, Secondary, and Tertiary categories.
Clicking the number in the Break column displays the Breaks window. If no break is taken, 0
displays in this column; clicking 0 displays the Breaks window with the statement No records
to display. Clicking another number, such as 10, displays the break type, start and end times,
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and minutes on the Breaks window. If the employee has taken more than 1 break, the previous
breaks are shown as well.

Figure 44: Check In/Out

Temporarily edit employee or device schedules
Click an employee or device name listed onCheck In/Out to edit the employee or device’s schedule,
including employee-device assignment. These are temporary changes that are only effective during
the check-in and check-out times defined.

1. Click Transport then Check In/Out.
2. Search for and select the employee on Check In/Out.
3. Click the employee name in the Employee column.

Figure 45: Temporarily Edit Scheduling Details
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4. On Temporarily Edit Scheduling Details change the device assigned to the employee by
selecting it from the list by the employee name.

5. Enter information in the applicable fields:

PurposeData

The maximum number of jobs that can be
assigned to this employee for this shift.

Maximum job assignments per shift

Shift/Check-In Times

The default check-in time of the employee is
automatically entered. To change the time,
delete the default and enter the change or click
the Time icon and select the time.

Check In*

The default check-out time of the employee is
automatically entered. To change the time,
delete the default and enter the change or click
the Time icon and select the time.

Check Out*

6. For each region that is part of this schedule, select the type of coverage that is associated to
the employee: P = Primary, S = Secondary, and T = Tertiary. You can scroll down to find the
applicable regions. The default setting can be Off for some regions. At least one region must
be selected.

7. Click the Breaks tab.

Figure 46: Breaks

8. To edit a break, click .

a. Change the type of break by selecting from Break Type
b. Change the break start in Start Time (using AM/PM format).
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c. Click

Figure 47: Start Time

9. To add a break, click Add Break.

a. Change the type of break by selecting from Break Type
b. Change the break start in Start Time (using AM/PM format).

c. Click

Figure 48: Breaks

10. To remove a break click .
11. Click Check In.

Figure 49: Check In/Out
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Check in employees or devices
Check in employees or devices displaying the check-in icon

1. Click Transport then Check In/Out.
2. Search for and select the employees or devices on Check In/Out. Devices must have an

employee associated to them to be checked in.

Figure 50: Check In/Out

3. If you selected a single employee or device click next to the employee or device name. If

you selected multiple employees or devices click at the top of Check In/Out.

Figure 51: Check In Employee(s)

4. Do one of the following:

> To check in the employees or devices now (current time), click Now.
> To check in the employees or devices when they are scheduled to be next available, click

Next Available.

Note: If an employee or device checks into a schedule with future
check-in time (by clicking Next Available), other details such as
Region, Idle time, and so on are not displayed until the schedule’s
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defined check-in time when the employee or device is automatically
checked in.

Figure 52: Check In

Check out employees or devices
Check out checked in employees or devices that display . A Transporter cannot check out when
a Stat job is assigned to them or if a transport job assigned to the Transporter is in an In Progress
or Delay (In Progress), Stay with Job status.

1. Click Transport then Check In/Out.
2. Search for and select the employees or devices that you want to check out.

Figure 53: Check In/Out

3. Click at the top of Check In/Out.

Start breaks for employees or devices
Start a break for checked-in employees or devices that display . A Transporter cannot go on
break when a STAT job is assigned to him or if a transport job assigned to the Transporter is in
an In Progress or Delay, Stay with Job status.

1. Click Transport then Check In/Out.
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2. Search for or select the employees or devices on Check In/Out.

Figure 54: Check In/Out

3. If you selected a single employee or device click on the line for that employee or device.

If you selected multiple employees or devices click at the top of Check In/Out.
Begin Break displays the names of the selected employees or devices. If there are breaks
already scheduled for the selected employees or devices, Scheduled Breaks is enabled.
Otherwise, you can only select an option from Non-Scheduled Breaks.

Figure 55: Begin Break

4. On Begin Break do one of the following, depending on what fields are enabled:

> Select from Scheduled Breaks.
> Select from Non-Scheduled Breaks.

5. Click Begin Break.
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End breaks for employees or devices
Manually end breaks for employees or devices before the scheduled end time where is displayed.

1. Click Transport then Check In/Out.
2. Search for and select the employees or devices on Check In/Out.

Figure 56: Check In/Out

3. If you selected a single employee or device click next to the employee or device name. If

you selected multiple employees or devices click at the top of Check In/Out.
4. On the End Break confirmation message click End Break.

Figure 57: End Break
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Chapter 5

Coverage Map

Coverage Map is view-only and displays Transporter coverage according to facilities and regions,
which you can change using the Organization selector. You can view the Primary, Secondary,
and Tertiary Transporters according to intervals of 15, 30, and 60 minutes. The number of
Transporters per interval and region are indicated in a colored icon: Primary Transporters in a red

icon , Secondary Transporters in a green icon , and Tertiary Transporters in a blue icon .
The current time interval is highlighted in grey.

Access Coverage Map
To access Coverage Map, click Coverage Map.

Figure 58: Transport > Coverage Map

Coverage Map is displayed. Initially, the coverage information is displayed in 60-minute intervals
according to facility or region listed in alphanumeric order. The number of open transport jobs
displays in parentheses on the right of the facility or region in the Facility/Region (Jobs) column.
The Primary, Secondary, and Tertiary boxes are checked by default to show this Transporter
coverage. You can change which types of coverage are shown by clicking a box to remove the
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check mark and clicking Apply. You can change the interval view by clicking the Interval arrow,
selecting 15 min or 30 min, and clicking Apply.

Figure 59: Coverage Map
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Chapter 6

Employee or Device Schedules

Depending on your organization's Transport Scheduling system option configuration you will see
the Employee or Device schedules tab.

Employee Schedules enables you to view, add, edit, and remove dates, times, regions, schedules,
and breaks assigned to employees. Employee names are displayed in alphabetical order by last
name (or alphanumeric order if letters and numbers are used for names). Multiple schedules can
be assigned to an employee.
The main difference between adding or editing a schedule for a device or an employee is that
when you add or edit a schedule to an employee, you can select a device onAdd or Edit Schedule.
When you add or edit a schedule for a device, you cannot select an employee on Add or Edit
Schedule. Instead, the device is assigned to the employee using Assets Maintenance or
Temporarily Edit Scheduling Details.

Add schedules
Add schedules for employees or devices.

1. Click Transport then Schedule.
2. Double-click the employee or device name under Employee Schedule or Device Schedule.

Figure 60: Schedule

3. Under Available Schedules click Add Schedule.
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Depending on the configuration you will see the Device or Employee field on Add Schedule.

Figure 61: Add Schedule

4. Select the Shift.
5. Enter information in the applicable fields. You must select at least one Region and one week

day. If you do not have information for an optional field, leave it blank.

PurposeField

If the application is configured for Employee
Schedules, select a Device.

Device

The maximum number of jobs that can be
assigned to device for this shift.

Maximum job assignments per shift

Effective Dates

Enter the required From date or click and
select the date. The application defaults the
From date based on the selected shift.

From*
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PurposeField

Enter an end date or click and select the
date.

Through

Weekday

The day fields are automatically selected based
on the selected shift. To change the default
selections, select or clear days. SU = Sunday,
M = Monday, T = Tuesday, W = Wednesday,
TH = Thursday, F = Friday, and SA = Saturday.

Day

Shift/Check-In Times

The default check-in time for the shift is
automatically entered based on the selected
shift. To change the time, click and select
the time (or enter the new time).

Check In*

The default check-out time for the shift is
automatically entered based on the selected
shift. To change the time, click and select
the time (or enter the new time).

Check Out*

6. For each region that is part of this schedule, select the type of coverage is associated to the
employee: P = Primary, S = Secondary, and T = Tertiary.

7. Click Breaks.
If breaks are set up as part of the shift, the default breaks are displayed. Otherwise, the statement
No records to display. is shown.

8. To remove a break, click .

9. To edit a break, click .

a. Select or enter a new Start Time.
b. Click .

Figure 62: Breaks
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10. To add a break, click .

a. Change the Break Type, if needed.

b. Enter a Start Time or click and select a time.

c. Click .

Figure 63: Breaks Tab with New Row

11. Click Save.

Edit schedules
Edit a shift, region, and schedule for an employee or device.

1. Click Transport then Schedule.
2. Double-click the employee or device name under Employee Schedule or Device Schedule.

Figure 64: Schedule
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3. In Available Schedules click next to the schedule you want to edit.

Figure 65: Edit Schedule

4. On Edit Schedule enter or edit the applicable fields. You must select at least one Weekday,
and at least one Region must have a P, S, or T selected. If you do not have information to enter
in an optional field, leave it blank.

PurposeData

If configured for Employee Schedules, select
a Device.

Device
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PurposeData

The maximum number of jobs that can be
assigned to device for this shift.

Maximum job assignments per shift

Effective Dates

Enter the required From date or click and
select the date. The application defaults the
From date based on the selected shift.

From*

Enter an end date or click and select the
date. Leave blank if there isn't an end date

Through

Weekday

The day fields are automatically selected based
on the selected shift. To change the default
selections, select or clear days. SU = Sunday,
M = Monday, T = Tuesday, W = Wednesday,
TH = Thursday, F = Friday, and SA = Saturday.

Day

Shift or Check-In Times

To change the time, click and select the
time (or enter the new time).

Check In*

To change the time, click and select the
time (or enter the new time).

Check Out*

5. For each region that is part of this schedule, select the type of coverage is associated to the
employee: P = Primary, S = Secondary, and T = Tertiary.

June 23, 2022 | Allscripts Patient Flow™ 22.1 86
Transport User Guide
Copyright © 2022 | Allscripts Healthcare, LLC
This page contains Allscripts proprietary information and is not to be duplicated or disclosed to unauthorized persons.

Edit schedules



6. Click the Breaks tab.

Figure 66: Breaks

7. To remove a break, click .

8. To edit a break, click .

a. Select or enter a new Start Time.
b. Click .

Figure 67: Breaks

9. To add a break, click .

a. Change the Break Type, if needed.

b. Enter a Start Time or click and select a time.
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c. Click .

Figure 68: Breaks Tab with New Row

10. Click Save.

Remove schedules
Remove a schedule from an employee or device.

1. Click Transport then Schedule.
2. Double-click the employee or device name under Employee Schedule or Device Schedule.

Figure 69: Schedule
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3. In Available Schedules click next to the schedule you want to remove.

Figure 70: Remove Schedule

4. Click OK.
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Chapter 7

Schedule Templates for Transport

Schedule Templates provides the ability to view, edit, add, and remove schedule templates for
employees or devices, depending on whether the Transport Scheduling system option is configured
to show employees or devices. These templates display as options in the Shift list onAdd Schedule
for the Employee or Device Schedules function. The Schedule Templates function works in a
similar way to the Employee or Device Schedules function except you are working with schedule
templates and not actual schedules assigned to employees or devices.

Add schedule templates
Add a Transport schedule template on Schedule Templates.

1. Click Transport the Schedule Template

2. On Schedule Templates click .

Figure 71: Add Template
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3. Enter information in the applicable fields. Most required fields are indicated by an asterisk.
Table 3: Add Template

PurposeField

Enter the name of the new schedule template.
After the template is saved, the name cannot
be edited.

Template*

Effective Date

Type the required From date or click and
select the date.

From*

If there is no end date, leave the Through date
blank. To limit the effective date, type the date

or click and select the date.

Through

Weekday

You must select at least one weekday. SU =
Sunday, M = Monday, T = Tuesday,W =
Wednesday, TH = Thursday, F = Friday, and
SA = Saturday

Weekday

Check In Time

Enter the time or click the Time icon and
select the time.

Check In*

Enter the time or click the Time icon and
select the time.

Check Out*

4. Click Save.

Edit schedule templates
Edit a transport schedule template on Schedule Templates.

1. Click Transport the Schedule Template
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2. Click for the template you want to edit.

Figure 72: Edit Template

3. Enter changes in the applicable fields. Most required fields are indicated by an asterisk.
Table 4: Edit Template

PurposeField

The name of the schedule template you are
editing. The name cannot be edited.

Template*

Effective Date

Type the required From date or click and
select the date.

From*

If there is no end date, leave the Through date
blank. To limit the effective date, type the date

or click and select the date.

Through

Weekday
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PurposeField

You must select at least one weekday. SU =
Sunday, M = Monday, T = Tuesday,W =
Wednesday, TH = Thursday, F = Friday, and
SA = Saturday

Weekday

Check In Time

Enter the time or click the Time icon and
select the time.

Check In*

Enter the time or click the Time icon and
select the time.

Check Out*

4. Click Save.

Remove schedule templates
Delete a template on Schedule Templates.

1. Click Transport the Schedule Template
2. Click next to the schedule you want to remove.

Figure 73: Remove Template

3. Click OK on Remove Template.
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Chapter 8

Operational Maintenance Tools

When a Transport Request is submitted in Allscripts Patient Flow™, the Intelligent Matching Engine
(IME) process automatically runs. The name of the Transporter who best matches these
requirements displays in the Assignment column for the request’s row on Transport Worklist. A
percentage displays on the right of the Transporter to indicate the percentage of the request’s
needs matched by the Transporter.
Operational Maint. Tools is used to automatically dispatch (Auto-Dispatch) the best-matched
Transporter. If Auto-Dispatch is turned on for a Transport region, the Transporter who has the
highest percentage match to the Transport Request is automatically assigned to fulfill the request.
Transporters can be automatically dispatched from 1, multiple, or all Transport regions.
Transport dispatchers also have the ability to manually dispatch from the Transport Worklist,
even when Auto-Dispatch is turned on. If a job is assigned by Auto-Dispatch, a user can assign
a different transporter to the job by clicking the "More Suggestions" link and choosing another
transporter. When a job requires 2 transporters, the first available transporter is assigned and a
hold status is applied to the job until the second transporter is available.
You must have authorized access to a Transport region in order to set Auto-Dispatch options. If
you set up Auto-Dispatch for a region, then it is set up for all users, not just on your page.

Note: Transport Dispatchers who use the Auto-Dispatch mode on
Operational Maint. Toolsmust check into their Transport Regions on the
Organizations list when checking into Allscripts Patient Flow™.

Access Operational Maintenance Tools
To access Operational Maint. Tools, click Operational Maint. Tools.

Figure 74: Operational Maint. Tools
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Operational Maint. (Maintenance) Tools is displayed.

Figure 75: Operational Maint. Tools

Functions on Operational Maintenance Tools
Your settings must be set up applicable to be able to view Auto-Dispatch options for Transport
regions. If you do not have authorized access for any Transport region, the following window
displays. More details for defining user settings are provided in the following section.

Figure 76: Operational Maint. Tools

Prerequisite for configuring Auto-Dispatch options
To set the Auto-Dispatch options for a Transport region, you must have a Transporter Dispatcher
role and the region must be selected in your organization settings. One or multiple Transport
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regions can be selected on the Organizations tab on User (Admin > User Maint as shown in
the following image.

Figure 77: Users

Select the applicable facility in the Facilities box, and select Transport Region in the Org Types
box. The Transport Regions associated with the facility display, and the applicable region can be
assigned to you by clicking the adjacent box to insert a check mark.

Configure Auto–Dispatch options
Use the following procedure to select the regions for Auto–Dispatch. Regions that are not selected
for Auto-Dispatch require manual dispatching of Transporters. The example in this procedure
shows some, but not all, regions selected for the Auto–Dispatch mode.

1. Click Operational Maint. Tools.
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Operational Maint. Tools is displayed.

Figure 78: Operational Maint. Tools

2. Do 1 of the following:

> To select all regions for Auto–Dispatch mode, click the All box to insert a check mark.
Check marks are inserted in all region boxes to indicate that all regions are selected.

> To select a region for Auto–Dispatch mode, click the region’s box to insert a check mark.
A check mark is inserted in the region’s box.

> To remove a region from Auto–Dispatch mode, click the region’s box to remove the check
mark.
The check mark is removed from the region’s box.

3. Click Save.
The changes to Auto–Dispatch are saved.
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Chapter 9

Status View

Status View enables Transport Requesters to view the status of jobs they have requested.
Transport requesters can only view the jobs they have requested (unless they have the proper
authorizations to view other requests, such as a Transport Supervisor might have). While this is
primarily a viewing page, you can add notes to or print the Transport Request. Requesters with
the proper authorizations can also cancel or edit the job. However, Edit might display for the
request; if it is clicked, Transport Request displays in view-only mode and cannot be edited.

Note: If the request is assigned, it cannot be edited.

Access Status View
To access Status View, click Status View.

Figure 79: Transport > Status View
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Status View is displayed.

Figure 80: Status View

Status View functions
To the right of the Organization selector are the Status and Sort boxes. When Status View is
displayed, the organizations that are selected are default organizations that are associated with
the transport user.

Initially, Status displays the default transport statuses. The default statuses include the following:

> Select All
> Assigned Delay
> Assigned
> Delay
> Delay In Progress
> Unassigned Delay
> Delay while Resource Acknowledge Receipt of Job
> In progress
> Resource Acknowledge Receipt of Job
> Unassigned

If you display delayed statuses, the delay status reason is also displayed.
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You can select as many different statuses as necessary. If you select the defaults, (see the following
graphic) and select Cancelled and Completed, the results include any records with cancelled
and or completed statuses.

Figure 81: Status Drop-down Menu Displaying Checked Defaults

Selecting an option in the Sort box sorts the data accordingly. You can sort by Time to Pickup,
Patient Name, From Location, and To Location.

Figure 82: Sort Menu

On the right of the Sort is the Hrs box. The Hrs box works in association with Cancelled and
Completed statuses. When you enter a number (for example, 24) in the Hrs box, and then click
Go, the jobs that were cancelled or completed in the previous 24 hours are displayed. You can
enter a maximum of two digits (72) in the Hrs box. (The larger the number of hours that you enter,
the longer the application takes to return data).
Clicking Search enables a search for a specific job. Clicking Refresh refreshes the window with
the latest information.
The Return Trip button enables users to schedule the return trip of a patient who was previously
transported from one location to another.
If you have the applicable authorizations, you can click Print, Edit, or Cancel on Status View or

click Notes ( or ) to add a note to a job.
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Chapter 10

Use communication devices

Some hospitals might use communication devices, such as a pager or a Personal Digital Assistant
(PDA), to inform Transporters of transport job requests. Pagers are used as an example in this
document, but other communication devices like PDAs are set up and assigned in a similar way.

Administrative setup
Communication devices are considered assets and are set up in theAdmin > Facility Maint. Your
system administrators defined devices like pagers using Assets Maintenance.

For the device to be available in the Transport module, the Transport Assignable box must be
checked on the Device tab as shown in the following image. The device asset is then assigned
to a facility, also in Admin > Facility Maint. For more information about setting up devices, refer
to the Allscripts Patient Flow™ Administration Tools User Guide.

Figure 83: Assets Maintenance

Schedule templates for the device must be defined if you are configured to associate schedules
with devices for transport (as opposed to schedules associated with employees as in the example
provide in this document). Employee/Device Schedules is then used to add specific schedules
and transport regions to the device.
System Administrators also set up Transporters in Allscripts Patient Flow™with sign on and Mobile
Devices with a Device ID. IDs are configured so Transporters can sign into the application with
their communications device.
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Device Information
Allscripts Patient Flow™ Mobile enables hospitals to centralize and integrate transport and bed
turnover activities with a mobile device, and is intended for use by transporters and housekeepers.
The functionality is designed around the daily key assignments that transporters and housekeepers
perform frequently.

For more information about mobile devices, refer to the Allscripts Patient Flow™Mobile User Guide.
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Chapter 11

Account Settings

Access Account Settings options
Based on role and associated permissions, you can access settings that are related to your
Allscripts Patient Flow™ account by clicking Account Settings.

The Account Settings options are based on your system roles and authorizations. The Check
Out and Message Subscription options are explained in the following sections.

Figure 84: Account Settings

June 23, 2022 | Allscripts Patient Flow™ 22.1 103
Transport User Guide
Copyright © 2022 | Allscripts Healthcare, LLC
This page contains Allscripts proprietary information and is not to be duplicated or disclosed to unauthorized persons.



Use the check out functions
Check Out enables you to check out or update message settings for your current Allscripts Patient
Flow™ session. Check Out looks similar to the Check In that displays when you first logged on
to Allscripts Patient Flow™. To change your roles or organizations in Allscripts Patient Flow™, you
must first check out of your current session on Check Out.

Check out of sessions or update checkout times
From Check Out, check out of your current Allscripts Patient Flow™ session or edit the checkout
time.

1. Click Check Out.
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Check Out is displayed.

Figure 85: Check Out

2. Do one of the following:

> To change the time for checking out, complete the following steps.
> Enter the changes in the Checkout Time box or click the calendar or time icons and select

the new date or time.
> Click Update.

The Checkout Time is updated.Check Out refreshes and displays the changed information.
> To check out immediately, click Check Out.

Check Out closes. You are checked out of the session and logged out of Allscripts Patient
Flow™. The statement You have successfully logged off. displays on Allscripts Patient
Flow™.
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Change message settings
Change your message settings on Check Out.

1. Click Check Out.
Check Out is displayed.

Figure 86: Check Out

2. If you want to use additional message delivery methods such as Email or Page, perform the
following steps in the My Messages section.

a. Click the box next to the message delivery method to select it.
A check mark displays in the box.
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b. For the methods chosen, click the corresponding arrow to select an option (for example, an
email address or pager number).
The selected option displays in the box.

3. To subscribe to additional message types such as Alert or Escalation, click theMessages arrow
and click the applicable boxes.
The Messages box displays Standard by default, which enables you to received standard
Allscripts Patient Flow™ messages (this cannot be cleared).
If selected, Alert or Escalation displays in addition to Standard in the Messages box.

4. Click Update.
Check Out refreshes and the message settings are updated.

Change roles, organizations, and messages settings
To change your roles or organizations in Allscripts Patient Flow™, you must first check out of your
current session.

The procedure to check out is explained in Check Out of a Session or Updating Your Checkout
Time. When you check out, you are logged out of the application. The following procedure assumes
you are logged out of the application and explains how to log on to Allscripts Patient Flow™ and
check in to select different roles, organizations, and messages settings for your session.

1. On Please Login, clear the Use Default Session box.

Figure 87: Please Login

2. Enter your Username and case-sensitive Password.
The information displays in the applicable boxes.

3. Click Login.
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Check In is displayed.

Figure 88: Check In

4. In the My Assignment section, click the Roles arrow and click the boxes on the list to select
the roles you want to use in Allscripts Patient Flow™. Only the roles that are assigned to you
display as options. When finished, click outside the list.
The selected roles displays in Roles. The Organizations box becomes available.
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5. Click the Organizations arrow and click the boxes on the list to select the organizations you
want to work in for Allscripts Patient Flow™ activities. Only the organizations that are assigned
to you display as options. When finished, click outside the list.
The selected organizations displays in the Organizations box. The My Messages section
becomes available. By default, the In Box box is checked to ensure that messages sent to you
using Allscripts Patient Flow™ go to the In box in the Messages section.

Figure 89: My Messages

6. If you want to use additional message delivery methods such as Email or Page, do the following
in the My Messages section:

> Click the box next to the message delivery method to select it.
A check mark displays in the box.

> For the methods chosen, click the corresponding arrow to select an option (for example, an
email address or pager number).

7. To subscribe to additional message types such as Alert or Escalation, click theMessages arrow
and click the applicable boxes.
Messages displays Standard by default, which enables you to received standard Allscripts
Patient Flow™ messages (this cannot be cleared).
If selected, Alert or Escalation displays, in addition to Standard, in the Messages box.

8. Click Check In to check into Allscripts Patient Flow™.
The Allscripts Patient Flow™ application displays on the Allscripts Patient Flow™ splash window.

Message Subscriptions
Standard messages have been defined by your hospital for specific roles. Therefore, your role
determines which messages you are automatically subscribed to when you log on to Allscripts
Patient Flow™. However, if you also must subscribe to other messages, you can select which
messages you want to subscribe to using the Message Subscription function. Messages are
triggered by events that occur in the application (Message Events), such as when a transport job
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is created. You can choose whether the messages are always delivered to you, for example, not
just during your work shift.
There might also be different versions of messages set up in Allscripts Patient Flow™ based on
the different audiences that might be interested in a Message Event. For example, a message
that is sent when a patient departs a bed might be of interest to a Bed Manager and to a
Housekeeper. The information contained in the message that each person receives might be
different. The Bed Manager would note that the patient has left and that the bed can be assigned
to someone else after it is cleaned. The Housekeeper would want to know the specifics about the
bed cleaning, such as the priority and whether it is an isolation cleaning.
Messages can be delivered to a number of different end points, such as to a recipient's email
account, to a pager, to a PDA or even to an application outside of Allscripts Patient Flow™. The
constraints applied by each of these end points can be very different. A message to an email
account can contain a lot of information. However, when the message is delivered to a pager, it
might be constrained to just a few hundred characters or less. To accommodate these varying
end point requirements, each message version might have multiple formats.
If there are different versions of a message, you can select the version that is most applicable to
your needs. If a message has only 1 version, only 1 option displays in the Version list, for example,
Standard. Even if there is only 1 version of a message, you must select a version for each message
you want to receive.

Note: For each message you subscribe to, you must select the version
of the message you want to receive.

Subscribe to messages
You can subscribe to messages using the following procedure. Because numerous messages are
available, you might need to scroll down to subscribe to different messages you want to receive.

1. Click Message Subscription.
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Message Subscription displays the messages available to you based on your user ID and
role.

Figure 90: Message Subscription

2. For each message you want to subscribe to, click in the applicable box in the Select column
to insert a check mark.
A check mark displays in the selected message box.

3. For each message you want always delivered to you, click in the applicable box in the Always
Deliver column to insert a check mark.
A check mark displays in the selected Always Deliver box for the selected message.

4. For each message you want directly assigned and only delivered to you if you are assigned to
a request (currently only for Bed Cleaning and Transport Requests), click in the applicable box
in the Explicit Delivery Only column to insert a check mark.
A check mark displays in the selected Explicit Delivery Only check box for the selected
message.

Note: This function is most likely assigned to a role, for example,
Transporter, rather than a specific user. If the Explicit Delivery Only
box is checked for a transport job assignment message, the message
goes to all users who are attached to the job. So if there is more than
1 Transporter assigned to the same job, they would both get the
message.
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5. For each message you subscribed to, click the Version arrow and select the version of the
message you want to receive.
The selected option displays in the Version box.

Figure 91: Version box

6. Click .
The information is saved.

Edit message subscriptions
You can edit message subscriptions using the following procedure. You can subscribe to more
messages, unsubscribe to messages, or edit version and delivery information. Because numerous
messages are available, you might need to scroll down to edit your message subscriptions.

1. Click Message Subscription.
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Message Event Subscriptions displays availablemessages andmessages you have previously
subscribed to.

Figure 92: Message Subscription

2. Do 1 of the following:

> For each message you want to subscribe to, click in the applicable box in the Select column
to insert a check mark.
A check mark displays in the selected box.

> For each message you want to unsubscribe to, click in the applicable box in the Select
column to remove the check mark.
The check mark is removed from the selected box.

3. Do 1of the following:

> For each message you want always delivered to you, ensure that a check mark displays in
the applicable box in theAlways Deliver column. If it does not, click the box to insert a check
mark.
A check mark displays in the selected box.

> For each message you do not want always delivered to you, ensure that a check mark does
not display in the applicable box in the Always Deliver column. If it does, click the box to
remove the check mark.
The check mark is removed from the selected box.

4. Do 1of the following:
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> For each message you want directly assigned and only delivered to you if you are assigned
to a request (currently only for Bed Cleaning and Transport Requests), click in the applicable
box in the Explicit Delivery Only column to insert a check mark.
A check mark displays in the selected box.

> For each message you do not want explicitly delivered only to you, ensure that a check mark
does not display in the applicable box in the Explicit Delivery Only column. If it does, click
the box to remove the check mark.
The check mark is removed from the selected box.

5. Do 1 of the following:

> For each message you subscribed to, ensure that a version is selected. If it is not, click the
Version arrow and select the version of the message you want to receive.
The selected option displays in the Version box.

> For each message you unsubscribed to, a version is no longer required. When you save the
information, the version is automatically deleted from the unsubscribed message.

6. Click .
The information is saved. If you unsubscribed from a message, the associated version is
automatically deleted.

Figure 93: Message Subscription
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Chapter 12

Transport and Sunrise Acute Care

Use the APF Transport tab in Sunrise™ Acute Care to manage Allscripts Patient Flow™ transport
jobs.

A Sunrise™ Acute Care clinician can complete the following tasks on the APF Transport tab:

> View transport jobs in the Status View.
> Edit or cancel a created transport job.
> Initiate transports on patients, materials, and equipment within patient context.

Create material only transport requests
From the APF Transport tab, create a material only transport request.

1. Log on to Sunrise™ Acute Care and click the APF Transport tab.

Figure 94: Create a material only transport request

2. Click Create Material Job.
3. Enter information into the following fields.

PurposeField

General

Select the facility.Facility*

The different types of transport jobs. These types are
used to set many values for a transport request.

Transport Type*

Request Information
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PurposeField

Click Priority and select the priority for the Transport
Request. Some transport requesters cannot see
Priority depending on their permissions.

Priority

If scheduled appointments exist for the patient, they
display here. If there are none, then No records
to display is displayed.

Scheduled Appts.

Select the location.

Note: From can be configured as either mandatory
or optional.

From*

Click the box for your options menu.To*

The application determines the next available date or
time based on system configuration and displays the
resulting date and time in Pick-up Time.
For a patient transport job, Edit must be clicked to
enter a different time. Schedule displays, and you
can click and drag the transport job to the applicable
time and date. For an equipment transport job, Edit
does not display, but you can click Pick-up Time and
change the date or time.

Note: Pick-up Time is not available when
Transport Type has not been selected. The default
pick-up time is the current date and time. When
Transport Type is selected, the Pick-up Time is
calculated considering the value entry (in minutes)
in Admin > Advanced Maint > Transport Type >
Next Available Period. The Pick-up Time value is
recalculated if the Transport Type is changed even
when it is manually altered in the box.

Pick-up Time*

Needs

Click Mode of Transport and select a mode. You
can configure the default value in Admin.

MOT

Click Personnel and select the personnel (Personnel
1).

Personnel

Enter the number of personnel for Personnel 1.Qty
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PurposeField

Click Personnel and select the personnel (Personnel
2).

Personnel

Enter the number of personnel for Personnel 2.Qty

Isolation

Click to insert a check mark in the applicable Isolation
boxes. (This is a configured area of the page.)

Isolation boxes

Equipment Delivery

Click to insert a check mark in the applicable
equipment options. (This is a configured area of the
page.)

Equipment options

Notes

Enter the information for the note. The note saves
when you save the job.

Add Note

Enter the phone number.Requestor's Phone

4. Click Save Job.
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The request displays in Status View in Sunrise™ Acute Care and Allscripts Patient Flow™.

Figure 95: My Application > SCM > APR Transport

Create patient transport requests
From the APF Transport tab, create a patient transport request.

1. Log on to Sunrise™ Acute Care.
2. Select a patient from the Patient List tab.
3. Select the APF Transport tab.
4. Click Create Job.
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Transport Type on Transport Request defaults to the types set up as either the patient being
moved or for patients moves in Allscripts Patient Flow™ Admin.

Figure 96: Create a for patient transport request

5. Enter information into the following fields.

PurposeField

General

Select the facility.Facility*

The different types of transport jobs. These types are
used to set many values for a Transport Request.

Transport Type*

Request Information

Click Priority and select the priority for the Transport
Request. Some transport requesters cannot see
Priority depending on their permissions.

Priority

If any other scheduled appointments exist for the
patient, they display here. If there are none, then No
records to display is displayed

Scheduled Appts.

Select the location. From can be configured as either
mandatory or optional.

From*

Select the location.To*
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PurposeField

The application determines the next available date or
time based on system configuration and displays the
resulting date and time in Pick-up Time.
For a patient transport job, Edit must be clicked to
enter a different time. Schedule is displayed and you
can click and drag the transport job to the applicable
time and date. For an equipment transport job, Edit
does not display, but you can click Pick-up Time and
change the date or time.

Note: Pick-up Time is disabled when Transport
Type is not selected. The default pick-up time is the
current date and time. When Transport Type is
selected, Pick-up Time is calculated considering
the value entry (in minutes) in Admin > Advanced
Maint > Transport Type > Next Available Period.
The Pick-up Time value is recalculated if Transport
Type is changed even when it is manually altered
in the box.

Pick-up Time

Needs

Select a mode of transport. You can configure the
default value in Admin.

MOT

Select the personnel (Personnel 1).Personnel

Enter the number of personnel for Personnel 1.Qty

Click Personnel and select the personnel (Personnel
2).

Personnel

Enter the number of personnel for Personnel 2.Qty

Isolation

Click to insert a check mark in the applicable Isolation
boxes. (This is a configured area of the page.)

Isolation boxes

Blood Products

Click to insert a check mark in the applicable blood
product options. (This is a configured area of the
page.)

Blood product options
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PurposeField

Notes

Enter the information for the note. The note saves
when you save the job.

Add Note

Enter the phone number.Requestor's Phone

6. Click Save Job.
The request displays in Status View in Sunrise™ Acute Care and Allscripts Patient Flow™.

Figure 97: My Application > SCM > APF Transport

Create patient move transport requests
From the APF Transport tab, create a patient move transport request. to request a round trip
transport job the user must have an auth role with Transport Request Round Trip Checkbox
selected.

1. Log on to Sunrise™ Acute Care.
2. Select a patient from the Patient List tab.
3. Select the APF Transport tab.
4. Click Create Jobs.

June 23, 2022 | Allscripts Patient Flow™ 22.1 121
Transport User Guide
Copyright © 2022 | Allscripts Healthcare, LLC
This page contains Allscripts proprietary information and is not to be duplicated or disclosed to unauthorized persons.

Create patient move transport requests



Transport Type on Transport Request defaults to the types set up as either the patient move
or the patient move in Allscripts Patient Flow™ Admin.

Figure 98: Create a patient move transport request

5. Enter information into the following fields.

PurposeFields

General

Select the facility.Facility*

The different types of transport jobs. These types are
used to set many values for a transport request.

Transport Type*

Request Information

Click Priority and select the priority for the Transport
Request. Some transport requesters cannot see
Priority depending on their permissions.

Priority

Available to users with appropriate auth roles. Select
to set up a round-trip transport.

Roundtrip

Enabled when Roundtrip is selected, instructs the
transporter to wait with the patient for the return trip.

Stay with job

If any other scheduled appointments exist for the
patient, they are displayed here. If there are none,
then No records to display displays.

Scheduled Appts.

The default location is the Facl/Unit/Pod portal for the
patient.

Note: From can be configured as either mandatory
or optional.

From*

Click To to see the options menu.To*
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PurposeFields

The application determines the next available date or
time based on system configuration, and displays the
resulting date and time in Pick-up Time.
For a patient transport job, click Edit to enter a
different time. Schedule opens, and you can click
and drag the transport job to the applicable time and
date. For an equipment transport job, Edit is not
displayed, but you can click Pick-up Time and
change the date or time.

Note: Pick-up Time is disabled when Transport
Type has not been selected. The default pick-up
time is the current date and time. When Transport
Type is selected, Pick-up Time is calculated
considering the value entry (in minutes) in Admin >
Advanced Maint > Transport Type > Next
Available Period. The Pick-up Time value is
recalculated if Transport Type is changed even
when it is manually altered in the box.

Pick-up Time

Needs

From Mode of Transport, select a mode. You can
configure the default value in Admin.

MOT

From Personnel select the personnel (Personnel 1).Personnel

Enter the number of personnel for Personnel 1.Qty

From Personnel, select the personnel (Personnel 2).Personnel

Enter the number of personnel for Personnel 2.Qty

Patient Equipment

Click to insert a check mark in the applicable Patient
Equipment boxes. (This is a configured area of the
page.)

Patient Equipment

Isolation

Click to insert a check mark in the applicable Isolation
boxes. (This is a configured area of the page.)

Isolation boxes

Notes

June 23, 2022 | Allscripts Patient Flow™ 22.1 123
Transport User Guide
Copyright © 2022 | Allscripts Healthcare, LLC
This page contains Allscripts proprietary information and is not to be duplicated or disclosed to unauthorized persons.

Create patient move transport requests



PurposeFields

Enter the information for the note. The note is saved
when you save the job.

Add Note

Additional Information

Enter the phone number.Requestor's Phone

6. Click Save Job to submit the transport request.
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The request is displayed in Status View in Sunrise™ Acute Care and Allscripts Patient Flow™.

Figure 99: My Application > SCM > APF Transport
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Figure 100: My Application > SCM > APF Transport with Roundtrip selected

Edit transport requests
From the APF Transport tab, edit a transport request.

1. Click Sunrise™ Acute Care and click the APF Transport tab.
2. Double-click the job record to edit.

Only jobs in the state unassigned or delayed unassigned can be edited.

Note: If Auto-Dispatch is enabled and the job is assigned before the
edits are completed and submitted, an error is returned indicating the
job has already been assigned and the edits were not saved.

3. Click Save Job.
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The edits display in Sunrise™ Acute Care and Allscripts Patient Flow™.

Figure 101: Edit transport request

Cancel transport requests
From APF Transport, cancel a transport job request.

1. Navigate to Sunrise™ Acute Care and click the APF Transport tab.
2. Double-click the job record to cancel.
3. Click Cancel Job.
4. Select a cancel reason and click Cancel Job.
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The job is removed from Status View in Sunrise™ Acute Care and cancelled in Allscripts Patient
Flow™.

Figure 102: Cancel a transport request

View job statuses
From the APF Transport tab, view the status of a job.

1. Navigate to Sunrise™ Acute Care and click the APF Transport tab.
2. To filter the page, complete the following actions:

> Select a facility from Filter by Facility.
> Select a job status from Filter by Job Status.
> Click Filter by From and select a location.
> Click Filter by To and select a location.
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The window refreshes to display the current filters.

Figure 103: View job status
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